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Introduction
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DSS Patient Search Tool was created under the VA’s innovation program by Document Storage Systems 
Inc.

The VA provides search functionality within the Medical Notes and Laboratory sections of CPRS for text 
and data. Many of the other sections in CPRS contain a large amount of data, and do not have search func-
tionality available for the VA health care providers. This causes extensive research and manual retrieval of 
data by health care providers, which is inefficient and time-consuming.  

Search options and capabilities provided by DSS Patient Search Tool give clinicians the ability to obtain 
health care information that was previously unavailable or missed. DSS Patient Search Tool also helps to 
improve workflow, efficiency and health care provider’s access to patient history.

This User and Administrator Guide describes the features and capabilities of DSS Patient Search Tool, and 
how to use them.



Overview

The Search Tool is located to the right of the drop-down menus at the top left section of the CPRS screen:

Figure 1: DSS Patient Tool Bar

If the Search button is disabled (greyed out), the user needs to contact the System Administrator to have 
the dynamic link library (dll) option added to the system.

DSS Patient Search Tool is organized into two main parts: Standard search and Advanced search. Both 
Standard and Advanced searches have essentially the same core capabilities, but Advanced allows searches 
that include date ranges where applicable, as well as additional search options that are specific to TIU 
Notes, Orders, and Reports.

Figure 2: Standard Search
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Figure 3: Advanced Search

The DSS Patient Search Tool has the following capabilities:

•   3 pull-down menus: File, Options, and Help.

•   Search Terms and Quick Search which speed up a search.

•   3 tabs for searches: Standard Search (default view), Advanced Search and Search Results.

•   Individual search areas which allow separate terms and date ranges (Advanced Search) for each of 
the six CPRS tabs (Discharge and Notes are included in TIU).

•   The Clear All button clears all the search terms to start anew.

•   The Save Std Search button saves the search terms for future use.

•   The Search button initiates a search, and the Cancel Search button cancels the search.

•   The CPU Priority section of the screen has two radio buttons, Patient Record Search and CPRS 
Application, which allow the user to prioritize their computer resources to perform a search or work 
in CPRS.
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•   The Filter By section of the screen has 3 radio buttons, Signed Notes, Unsigned Notes, Uncosigned 
Notes, which allow the user to filter and adjust the TIU returns.

•   The Order Status drop-down menu allows the user to select the status of orders to be searched.

•   The Select Report button allow the user to choose reports to run and search.

•   The Total Found section of the status bar shows how many instances of the search term were found.

The five areas that can be searched are: TIU Notes, Problem Text, Consults, Orders, and Reports.

To perform a Standard search, search terms (words, values, etc.) are entered into the applicable text box of 
the desired search area, e.g., Consults. The Search button is then clicked, and the search is initiated. Any 
search terms that are found are presented on the Search Results tab as a “drillable” list; i.e., a tree-view, 
from which specific search results may be selected, with any found search terms displaying in bold font, 
and a user-selected color.

The Advanced search works just like the Standard search, but allows search results to be filtered by date-
range.

DSS Patient Search Tool has the capability to perform searches with or without case-sensitivity, as well as 
whole word and partial word.

Search terms can be saved for future use, and are user specific. One of the search areas supported by DSS 
Patient Search Tool is CPRS Reports. User selected reports can also be saved for future use to avoid having 
to select report(s) of interest each time a report search is required.

DSS Patient Search Tool offers users a selectable CPU Priority, which gives processor precedence to either 
CPRS or the Patient Search Tool, at the user’s discretion. This feature helps to ensure that the performance 
of CPRS is minimally impacted while DSS Patient Search Tool is running.

DSS Patient Search Tool also offers some time-saving features that allow for quicker search term entry 
when searching multiple areas of interest, as well as a way to search all areas at once by using a simple dia-
log box.
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Drop-Down Menus

File Menu

Figure 4: File Menu

The File drop-down menu has 2 active options, Saved Searches and Exit. The Saved Searches are lists 
(Standard or Advanced) of user defined search terms (not search results) for edit boxes corresponding to 
the TIU Notes, Problem Text, Consults, Orders, and Reports sections.

Clicking the Saved Searches option displays the Saved Searches screen, from which previously saved 
searches can be selected. Standard and Advanced searches are saved in separate lists. Which list is cur-
rently available depends upon which tab (Standard or Advanced) is currently active.

Figure 5: Standard Searches Screen

The Search screen has 4 buttons:

•   Open Selected Search – Opens a selected Standard search.

•   Delete Selected Search – Deletes a selected Standard search.

•   Delete All Standard Searches – Deletes all Standard searches appearing in the list.

•   Delete All Searches – Deletes All searches, both Standard and Advanced.
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Options Menu

Figure 6: Option Menu

The Options drop-down menu has the following options:

•   Title Search – Compares user-defined search terms against record titles. The text in the body of a 
record is not searched. Standard searches default to Title Search.

•   Document Search – Compares user-defined search terms against the text in the body of records. 
The text in the title is not searched. Advanced searches default to Document Search, but can also do 
a Title Search. 

•   Search Term Bold Color – Opens a Color window which allows the user to set the color of the 
searched text within the document display.

Figure 7: Color Window

•   Whole Words – Forces the search to match the entire word search text.

•   Case Sensitive – Forces the search to match upper and lower text case.

•   Show Results on Search Completion – Displays the Results tab of the DSS Patient Search Tool 
when the search is complete.
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Help Menu

Figure 8: Help Menu

The Help drop-down menu has the following options:

•   About – Provides information about the DSS Patient Search Tool including the version number.

Figure 9: About Screen

•   Show Broker History – Technical support may ask the user to show the Broker History when track-
ing down a problem.

Figure 10: Broker Calls Screen
October 2012 DSS Patient Search Tool User and Administrator Guide v1.0 7



Pop-Up Menu

To access the pop-up menu, right-click anywhere in the screen. The menu displays the following options:

•   Select All

•   Copy Selection to Clipboard

•   Find

Figure 11: Pop-up Menu
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CPU Priority

The DSS Patient Search Tool shares CPU allocation with CPRS. To speed the search tool retrieval, priority 
can be set to the DSS Patient Search Tool at the upper right of the DSS Patient Search Tool screen. This 
setting also affects the speed of the document processing on the Display Pane of the Search Results tab.

Figure 12: CPU Priority
October 2012 DSS Patient Search Tool User and Administrator Guide v1.0 9



Performing a Search

Standard Search Tab

To perform a standard search:

1.   Select the Standard Search tab on the DSS Patient Record Search screen.

2.   Choose any TIU filters, display preferences, or document classes.

3.   Click in the Search Terms field and type in key words to search for, separated by a space. Then 
choose the number of instances to display.

4.   Active Orders is the default status. The user can select order statuses using the drop-down menu.

5.   If the user has search terms for reports, select the reports to run.

Figure 13: Standard Search Tab

6.   Click the Search button.
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To search for terms (from either Standard or Advanced search) on Reports, first select the reports to run 
and then search. Clicking the Select Reports button on the Reports area of the DSS Patient Search Tool 
opens the following window which is identical to the CPRS Reports tab selection. The instructions are on 
the window.

Figure 14: Select Reports
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Search Terms Button

Figure 15: Search Terms

The Search Terms button (upper left of the DSS Patient Search Tool) opens the following window. This is 
a fast way to enter search terms if they are the same for each area. The instructions are displayed in the 
window.

1.   Click the Search Terms button.

2.   Type in the terms in the Search Terms: box.

3.   Select any or all of the CPRS areas to apply the terms to.

Figure 16: Search Terms Window

4.   Click the Apply Search Terms button.
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Quick Search Button

Figure 17: Quick Search

The Quick Search button (upper left of the DSS Patient Search Tool) opens the following window. This is 
the fastest way to perform a search for terms. The instructions are displayed in the window.

1.   Click the Quick Search button.

2.   Type in the terms in the Search Terms: box.

3.   Select a Start Date.

Figure 18: Quick Search Window

4.   Click the Search button.
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Save Search Button

Figure 19: Save Standard Search

Once a search has been entered, it can be saved for future use. Saved searches are specific to the Standard 
Search or Advanced Search tab. Clicking the Save Std Search button (or the Save Adv Search button if 
on the Advanced Search tab) opens the naming prompt. Once saved, the search is available from the File 
drop-down menu (see the Drop-Down Menus section for more information).

Figure 20: Name of Search
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Advanced Search Tab

The Advanced Search tab (second tab top left) has identical features to the Standard Search, but offers 
start and stop date ranges for all areas. The Search Terms and Quick Search buttons also prompt for date 
ranges, but otherwise function the same as in the Standard Search. Advanced searches can be saved in the 
same manner as a Standard search, but are visible from the File drop-down menu only on the Advanced 
Search tab.

1.   Select the Advanced Search tab.

2.   Choose any TIU filters, display preferences, or document classes.

3.   Click in the Search Terms field and type in key words to search for, separated by a space. Then 
choose the number of instances to display.

4.   Select a Start Date and End Date for the search.

Figure 21: Report Selection

5.   Click the Search button.
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Cancel Search Button

To cancel a search in progress, click the Cancel Search button on the lower bar. Selecting a different 
patient in the CPRS also cancels a search.

Figure 22: Cancel Search Button

Close Button

To close the DSS Patient Search Tool without closing CPRS, click the Close button in the lower right of 
the DSS Patient Search Tool window. Both applications close if CPRS is closed after the user receives a 
Warning Message stating that the search data will not be saved.

Figure 23: Close Button
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Search Results Tab

Selecting the Search Results tab displays any available search results. If the Show Results On Search 
Completion option is selected on the Options drop-down menu, the tab automatically displays. The 
Results Pane (left side of the screen) displays documents returned by the search in an expandable outline 
form. Selecting a document in the results pane displays the text in the Details Pane (right side of the 
screen) with the search term text in a bold, colored font.

Figure 24: Search Results Tab
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Administrator Guide

Minimum Requirements

The minimum software requirements for the DSS Patient Search Tool are:

•   CPRS v1.0.27.90 (modified for DSS Patient Search Tool)

•   DSSPatientRecordSearch.DLL version 1.0 or higher in the same directory as CPRSChart.exe 
(v1.0.27.90)

•   Required Namespace: DSIWA

•   KIDS Build DSIWA_CPRS_SEARCH_TOOL_1_0.KID

Configuration Guide for the VA Sandbox

CPRS Location

On the VA Sandbox, the CPRSChart.exe (v1.0.27.90) file is located in S:\Innovation-259. There may be 
various versions of CPRSChart in that directory. The most current version, and the one pointed to by a 
Sandbox desktop shortcut is CPRSChart.exe.

Patient Record Search Tool DLL Location

The DSS Patient Search Tool is implemented as a .DLL (dynamic link library), which is launched from the 
CPRS main menu by clicking the Search button.

The .DLL filename is DSSPatientRecordSearch.dll. This file must reside in the same directory as 
CPRSChart.exe (v1.0.27.90). On the VA Sandbox, that directory is S:\Innovation-259. Both 
CPRSChart.exe (v1.0.27.90) and DSSPatientRecordSearch.dll must be physically located in that directory.
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Create a Desktop Shortcut to CPRS 27.90

Create a Desktop shortcut to CPRSChart.exe (v1.0.27.90). Right-click and select the Properties option 
from the drop-down menu. In the DSS Patient Search Tool Properties screen, select the Shortcut tab and 
enter the following:

Target: S:\Innovation-259\CPRSChart.exe s=172.19.100.95 p=9259
Start In: S:\Innovation-259

Figure 25: Shortcut Tab

To run CPRSChart.exe, double-click the Desktop shortcut. Attempting to run it by double-clicking the 
CPRSChart.exe file in the Innovation-259 folder will not work. This is because CPRS needs the Server and 
Port numbers from the Shortcut Properties (above).
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Cache Terminal Instructions

To get a Terminal session, SSH must be used. Terminal from the Caché Cube menu will NOT work. To ini-
tiate a Terminal session on the VA Sandbox, do the following: 

1.   From the Start menu, under All Programs, select Attachment Reflections, Host – UNIX, and 
Open VMS. 

2.   Select the Connection Setup... option from the Connection drop-down menu.

Figure 26: Connection Setup

3.   Change to SECURE SHELL. 

Figure 27: Secure Shell
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4.   Use vaphsdb05 for the Host name. 

Figure 28: Host Name

5.   Click Connect. If a “Host Key Authenticity” message displays, click Always. 

6.   Log in with: 

Username: vhaino259 
Password: vhaino259 

Figure 29: Username
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CPRS Logins on the VA Sandbox

The following CPRS Access/Verify Codes are pre-configured for general use on the VA Sandbox: 

VistA Administrator

Access code: 01vehu 
Verify code: vehu01 

Doctor/Provider

Access code: 1radiologist 
Verify code: radiologist1 

Pharmacist

Access code: 1pharmasist 
Verify code: pharmasist1 

VistA Programmer

Access code: 1programmer 
Verify code: programmer1 
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